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This manual describes the most basic operation of our Varian NMR spectrometers with 
Vnmrj 2.2D and above and Chempack 4.1.  More advanced techniques, like two-
dimensional spectroscopy, are described in separate documents in the NMR Facility's 
web site at http://www.umich.edu/~chemnmr/docs.html.  Full documentation for Vnmrj is 
available from its help menu and on printed copies of the manuals located the lab.

Please note that reading our Rules, Safety Information, and Instrument Care and Good 
NMR Practices, is a requirement before you start using our Facility.  You are also 
required to read and understand our instrument's capabilities and limitations.  All this 
information can be found in our web site.  There is also a training video available in one 
of the workstations (Copper). 

To reserve instrument time, we use an online scheduler which is accessed from our web 
site at the bottom  of the News page.  On that page, we regularly publish important news 
and information about the NMR Facility.  Please check the news every time you want to 
make a new reservation for current news and information. 

Currently, the lab is equipped with five Varian NMR spectrometers: two 400MR (named 
Gallium and Cobalt), one Inova 500 (Tin), one VNMRS 500 (Tellurium) and one VNMRS 
700 (Ytterbium).  These have a variety of capabilities and each is best suited for some 
particular experiments.  For example, Cobalt has better sensitivity for carbon-13 than Tin, 
but the latter has better sensitivity for protons.  For a complete list of capabilities and 
limitations, consult our web site or ask the staff.  

The lab also has five workstations where users can process and plot their spectra.  One 
of them (copper) can also operate with the Windows operating system and has available 
a copy of MestReLab's MestReNova for NMR processing and some other chemistry-
related software.  Spectra stored in the spectrometers can be accessed from the 
workstations via a local network.  Use of the workstations is free of charge.  

If you encounter a problem when using Vnmrj or one of the spectrometers, read 
“Common Problems and Solutions” in the Documentation section of our web site or ask 
the staff for help.   

Vnmrj overview
Vnmrj runs on computers under the Linux operating system.  Users in our facility receive 
an account on each computer in the lab which can be accessed with their UM uniqname 
(user name) and password.  Each user has a home directory or folder located in 
/home/username.  Inside that folder, Vnmrj stores its user-related files in a folder 
named vnmrsys and data files (spectra) in vnmrsys/data 
(/home/username/vnmrsys/data).  

Vnmrj can operate in three modes: experimental, walkup and imaging.  Because we use 
only the experimental interface by default in our Facility, this manual will cover only that 
interface.  The walkup interface is a simplified  mode of operation with many limitations 
and is meant mostly for automation. 

http://www.umich.edu/~chemnmr
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A data set in Vnmrj consists of the NMR data itself (FID) and its associated parameters 
for acquisition and processing; and it is stored not as a single file but as a folder with an 
.fid extension containing several files.  Data sets are loaded from the File menu.  In 
addition, Vnmrj uses the concept of “workspaces” (analogous to opening several files in a 
word processing program) to perform several tasks simultaneously.  Workspaces (also 
called experiments) are separate regions of computer memory independent of each other 
where spectra and parameters are kept.  For example, you can be performing a proton 
acquisition in workspace 1, while setting up acquisition parameters for a carbon-13 in 
workspace 2, or plotting a two-dimensional spectrum in workspace 3.  The number of 
available workspaces is essentially unlimited, but they must be created once before they 
can be used.  Only workspace 1 already exists in any user account by default.  Once 
created, data in any workspace is persistent between user logins.  To create an additional 
workspace, select from the main menu: File > Create Workspace.  To move 
between workspaces, type a command jexp (“join experiment”) immediately followed by 
a number; for example jexp3 will take you to workspace 3, if it already exists.  Or you 
can also select one from the menu Tools > Workspace Information....  The 
workspace you are working on is displayed in the blue bar on top of the graphics display. 
The dynamic use of workspaces increases the efficiency when using Vnmrj and is highly 
recommended.  For example, after acquiring a proton spectrum in experiment 1, you can 
copy the FID to experiment 3 with the command mf(1,3) (move fid from 1 to 3) and 
setup a 2D experiment based on the parameters you selected for the 1D spectrum. 

Please refer to the figure below for a brief description of the layout of the graphical 
interface. 
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Sample preparation
Please use high quality, 5 mm NMR tubes like the Wilmad 
528-PP-7, available from Aldrich.  Cheap tubes may not spin 
properly and they may be more difficult to shim.  The tubes should 
be at least 7 inches long.  Do not use disposable tubes or 
broken/cracked tubes.  The solvent volume should be about 0.6 mL 
(about 4 cm in the tube).  Using less volume is possible but you will 
have to center the sample volume with the coil location shown in 
the depth gauge, and shimming may be difficult.  For very small 
sample quantities, using a Shigemi tube matched to your solvent's 
magnetic susceptibility is recommended.  For maximum resolution, 
the solution should be free from insoluble materials.

To position the tube in the magnet and spin it, a turbine (the 
“spinner”) and depth gauge are used.  Insert the sample tube in the 
spinner by pushing it gently along the hole while applying a little 
back and forth rotation until the tube goes all the way to the bottom 
of the depth gauge as shown below.  Be careful: most tube 
breakages occur when inserting the tube in the spinner.  Do not 
force it if it feels like a very tight fit.  Do not insert the tube with the 
spinner already inside the depth gauge: insert it outside and then 
adjust the depth (if the tube breaks inside the gauge, the gauge will 
need to be cleaned).  Do not insert the tube in the spinner over the 
keyboard or desk (if the tube breaks, you will contaminate and damage the keyboard and 
working surface).  When inserting or retrieving the sample from the magnet, hold the 
spinner from the top rim (the black stripe with white dots).  Avoid touching the lower part 
(the shaft).    

Insert the tube in the spinner by pushing 
it gently along the hole while rotating it 
back and forth.

Hold the spinner from the top rim.

To insert the sample in the magnet, type e on the command line or click the Eject button. 
Position the spinner and sample on the stream of nitrogen on top of the magnet and type 
i or click the Insert button.  

Do not lean against the magnet when loading your sample!  And 
never, ever, insert an empty spinner or a tube without spinner in the 
magnet.

For better sensitivity 
when using limited 
amounts of sample, 
a Shigemi tube is 
recommended.
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Do not hold or touch the spinner on the 
shaft

Do not hold the spinner from the NMR 
tube.

Do not insert the tube by forcing it in the 
spinner's hole, or when the spinner is 
mounted in the depth gauge.

If less than the recommended volume is 
used, center the solution's column with 
the center black line on the gauge's 
meter. 

If you break your tube and spill the solution, you are responsible to 
thoroughly clean everything and make sure no hazard remains to 
other users or the instruments.  You should also let us know 
immediately to make sure everything is satisfactory.  Users who 
don't show consideration for fellow users or our instruments will be 
banished from the NMR Lab.

Preparing for acquisition
If you absolutely don't need more than simple, routine spectra; don't want to learn to 
optimize your experiments; or don't even care about the details of NMR spectroscopy but 
need some NMR spectra, there is an automation mode that can do everything for you 
except for loading the sample in the magnet.  If that is what you want, go to the section 
Automated Acquisitions; otherwise keep reading.  
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Before you can run any NMR experiment you will need 
to specify a pulse sequence to be executed and 
several acquisition parameters like pulse durations, 
frequencies and powers; delays; the number of data 
points; and many others.  Additionally, many of these 
parameters require proper calibration.  All these 
parameters have been calibrated and given default 
values by the staff, and are stored on files in the 
computer's hard disk.  To run an NMR experiment, you 
must first load a set of parameters.  The parameters 
are then kept in portions of memory called workspaces 
where acquisition and processing will take place.   The 
value of the parameters can be changed on the 
command line by typing the parameter's name followed 
by the equal sign and the new value, for example 
sw=5000.  If the value is alphanumeric, it must be 
enclosed in single quotation marks, for example 
gain='n'.  To find the current value of a parameter, 
type its name followed by a question mark, for example 
nt?.  You can also inspect and change most common 
parameters from the appropriate parameter panel.  

To load a parameter set, select an experiment from the 
Experiments menu.  Notice that the Experiments 
menu is divided in 3 parts.  The sections named Setup NEW parameters for... and 
Setup NEW parameters to do... will replace all current parameters with default 
values for the experiment requested; while Convert current parameters to do... 
will use the existing parameters in the current workspace and add any additional 
parameters needed for the experiment.  For example, before doing a 2D experiment, it is 
a good practice to first measure a 1D proton spectrum, check on the quality of the 
shimming, and optimize parameters (e.g. spectral width, transmitter offset, relaxation 
delay).  To do this, first select Setup NEW parameters for... > Proton, modify 
the parameters, take a spectrum and save it; and then select the 2D experiment from 
Convert current parameters to do....  But if you don't care to optimize anything 
and just want your 2D spectrum with default parameters, you can choose it directly from 
Setup NEW parameters to do.... 

After the sample has been inserted but before the acquisition is started, the spectrometer 
must be prepared.  This involves enabling the lock, tuning the probe and shimming the 
magnet.  First, go to the Start, Standard parameter panel and choose a solvent.  At 
this point you can enter a Comment to identify your sample, and choose a different 
spinning rate or temperature.  We will deal with variable temperature operation later.  The 
information in Sample Name, Lot Number, Notebook, Page and Email is used 
by vnmrj's database to locate spectra and is optional for normal operation.  
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Locking the sample

In order to take a high resolution spectrum, the magnetic field has to be stable and 
homogeneous.  If the magnetic field changes during the course of the acquisition, the 
signals will broaden and the spectrum will have poor resolution.  To keep the field stable, 
the spectrometer has a mechanism (the lock system) that corrects the field's drift as it 
occurs .  The drift is monitored using the absorption frequency of the solvent's deuterium 
resonance (the lock signal).  As this frequency changes due to changes in the field's 
strength, an electric current is applied to a coil in the magnet that increases or decreases 
the field's strength to keep the field steady and the signal in the same position.  To 
continuously monitor the deuterium signal, the spectrometer has a dedicated deuterium 
channel.  When you “lock” your sample, the lock system starts monitoring the solvent's 
deuterium frequency (if it can find it).  

But before you attempt to lock your sample, it is first necessary to set the appropriate lock 
parameters: Z0, lock power, lock gain and lock phase.  All these parameters are found on 
the Standard, Lock parameter panel shown below and they vary from solvent to 
solvent and from spectrometer to spectrometer.   To simplify the operation of our 
spectrometers, so the user doesn't have to remember the appropriate lock parameters, a 
macro called setlock was created that loads all lock parameters for the most common 
solvents (CDCl3, C6D6, CD2Cl2, CD3COCD3, CD3CN, THF-d8, CD3OD, DMSO-d6 and D2O; 
other solvents may need manual setup).  After choosing your solvent in the Start, 
Standard panel, type setlock.  This loads the lock parameters and also the current 
shims for the probe and solvent in use.  But you still need to check that the lock has been 
established and, if needed, fine tune Z0.  

Before proceeding with the locking procedure, we will describe the operation of the 
buttons in the Lock and Shim panels.  These buttons work in a 
different manner than all other buttons on vnmrj's interface.  When you 
click one of them, the value of the parameter it controls increases or 
decreases by the amount indicated on the right side of the button; the 
value increases when the right mouse button is used and decreases when the left mouse 
button is used.  To make fine or coarse adjustments, the increment/decrement amount 
can be changed between values of 1, 10 and 100 units by clicking with the middle button. 

The lock field, Z0, controls the magnetic field strength and consequently, the frequency 
at which the signal from the deuterated solvent resonates.  The value of Z0 is fairly 
constant for a particular solvent and magnet, but the value changes slowly over long 
periods of time (weeks or months) as the magnet's field drifts.  It is adjusted so the lock 
frequency is in resonance with the solvent's absorption frequency.  To do this, press the 
Lock Scan button on the Start, Lock panel and change Z0 (left or right click the Z0 
button) until the lock signal appears on screen as a flat, zero-frequency sinusoidal signal. 
The figure below shows the lock scan when Z0 is far from resonance (left), when it is 
close (middle), and when it is on resonance (right).  Usually, it is not necessary to be 
exactly on resonance, but you should be close.  You can also press the Find z0 button to 
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have vnmrj find it for you, but be aware that Find z0 may reset the lock power to a 
saturating value.  

Z0 is far from resonance Getting closer... Z0 is on resonance

The lock power controls the RF radiation's power that is applied to the solvent's 
deuterium signal.  Low powers give very weak signals and a poor, noisy lock while too 
high powers produce signal saturation leading to lock instability.  The optimum power is 
determined mainly by the relaxation time of the solvent and probe design.  For example, 
in the Inova 400 the optimum power for CDCl3 is about 24 and that for acetone-d6 is 
about 6; using a power of 24 for acetone will certainly lead to severe saturation and 
instability, and shimming will be impossible.  

The lock gain provides amplification to the lock signal.  Its value is not really important 
as long as a lock intensity of at least 60% is maintained during acquisitions.   

The lock phase is mainly determined by the electronics and to a lesser extent by the 
solvent.  Usually it is not critical to optimize it (the default parameters already have a 
good value) as long as an intense lock is produced.  However, if you are unable to lock, 
make large changes (of ~30 units) and see if it helps.  Optimize it if needed.  

Clicking the On button in the Start, Lock panel engages the lock system.  If the lock 
system didn't engage (the lock level is less than 10%), try increasing temporarily the 
power or the gain to kick it in, but once the lock is set, turn the power back to its previous 
value or you may saturate the lock signal.  

Tuning the probe

In a typical NMR experiment, the nuclear spins in the sample are excited by the 
application of one or more short pulses of radio-frequency (RF) radiation, and eventually 
they precess freely across the axis of the external magnetic field, thus inducing an 
electric current in a coil located close by.  The coil is located in the probe, whose main 
purposes are to hold the coil(s) close to the sample and to generate the strongest 
possible signal from the weak fluctuating currents induced by the nuclear spins as they 
precess.  For the coils to be able to transmit the RF pulse to the sample and to detect the 
induced NMR signal efficiently, the coil circuitry should be optimized.  The process is 
known as “tuning”, and it is analogous to tuning your radio receiver to a particular radio 
station: if not properly tuned, your music will be noisy.  Proper tuning is essential to obtain 
high quality NMR data.  The exact frequency depends of course on the nucleus to be 
measured, but also on the solvent.  The adjustments are made by turning the tuning and 
matching rods located on the bottom of the probe, which in turn adjust variable capacitors 
inside the probe body.  

In our lab, the procedures for tuning are different depending on the probe used:

• The probes in the Inova-400 and in Cobalt are permanently tuned to 1H, 19F, 13C 
and 31P and do not require additional tuning.

• The default probe in the Inova-500 is always tuned to 1H and 13C and does not 
require further tuning by the user but can be tuned upon request for special 
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experiments.  This instrument has another probe that can be tuned to any 
nucleus from 31P to 15N.  If needed, the staff will install and tune it; users are not 
allowed to do this except when properly trained.

• The other MR400 instrument (Gallium) is 
equipped with an automatic tuning device 
(protune unit) that can tune the probe for the 
user.  The software is set up to do automatic 
tuning before acquisition when a new sample is 
inserted in the magnet or when the nucleus or 
the solvent is changed.  All you have to do is 
start the acquisition by clicking the Acquire 
button (typing go or ga will not do the tuning). 
Alternatively, you can request the tuning to be 
done at any time by clicking the Tune button on 
the Start, Standard panel and then click 
the appropriate button for your nucleus; or type in any desired nucleus (letters 
first, numbers last: eg. Pb207) followed by clicking Tune to Criterion.  

• The VNMRS instruments (Tellurium and Ytterbium) are also equipped with 
protune units that can tune the probe for the user as explained above. 
Additionally, these instruments require a “quarter wavelength cable”, matched to 
the frequency of the nucleus, to be changed at the   preamp   interface before   
acquisition of heteronuclei other than   13  C  .  Ask the staff for details.  

Unfortunately, the protune unit is notoriously unreliable.  It usually does a good job, 
especially for 1H, 19F and 13C, but for other nuclei it may fail.  This is especially true for 
some nuclei like 11B and 199Hg in our 400-MR spectrometers Cobalt and Gallium.  If 
automatic tuning fails 
(characterized by the motors in 
the unit moving up and down for 
more than 1 minute), you will 
have to tune the probe manually 
as described in a separate 
writeup (Probe tuning with the 
protune modules).  For this 
reason it is always a good idea to 
verify if tuning was successful, 
especially before starting a long 
acquisition and it will only take a 
few seconds.  From the main 
menu choose Tools > Probe 
Tuning > Manually Tune 
Probe.  Then select Tune RF 
channel (1 for H1 or F19; 2 for 
anything else) and enter a 
nucleus in the Center Frequency 
field (letters first, numbers last: eg. Pb207).  After clicking on Start Probe Tune the 
display should show a V-shaped dip centered with the blue line; if not, tuning was not 
successful and you will need to manually tune the probe or try automatic tuning again. 
Click Stop Probe Tune followed by Quit to return to normal operation.  

Shimming

One of the most important factors to get a good quality NMR spectrum is shimming. 
NMR spectroscopy demands a homogeneous magnetic field over the whole of the 
sample volume located within the probe's detection coil.  If the field is not homogeneous, 
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the resulting spectra will suffer from distorted line shape which in turn leads to poor 
resolution and sensitivity.  For this reason, the field has to be optimized to every sample 
that is introduced in the magnet.  The process of adjusting the field's homogeneity is 
called “shimming”.  Shimming is achieved with the help of coils (called shims) located at 
strategic places around the sample in the magnet.   By applying different electrical 
currents to these coils, it is possible to compensate for local deficiencies in the field 
homogeneity.  There can be from 12 to 32 or even more different shims depending on 
magnet design.   These have names related to the axis of the field component they affect 
the most.  For routine operation it is usually necessary to shim only the first two or three Z 
shims (Z1, Z2, Z3).  

To shim the magnet you will need an indicator of field homogeneity.  This can be provided 
by the lock signal, whose intensity is proportional to the field's homogeneity.  To shim, you 
make changes to the shims and observe the lock intensity.  Continue making changes 
until a maximum intensity is reached.  The actual value is not important, only that you 
cannot improve it any more.  Unfortunately, shimming is not as simple as adjusting each 
shim in sequence because they interact with each other.  That is, changes in one shim 
may induce a change in another.  Fortunately, the interactions are not very large and are 
well understood.  For example, odd order shims (Z1, Z3, Z5) interact mainly with each 
other and only slightly with even order shims (Z2, Z4); and the other way around.  There 
are several procedures for shimming that take into account these interactions.  You 
should start by loading a set of standard shims from the computer (this is accomplished 
with the setlock macro).  These were determined by the Facility staff using a standard 
sample in a high quality tube.  Once loaded, the magnet is already pre-shimmed and 
requires only fine tuning of a subset of all its shims.  Here, a very simple procedure for 
routine applications is described.  

Go to the Start, Shim parameter panel.  The lock strength, shown in the “clock” 
display, should be at least 10-20% before starting or shimming will probably be a useless 
exercise.  If it is less than that, check the position of the tube on the spinner; make sure 
that you have at least 4 cm of solvent in the tube and that the lock has indeed “engaged”. 
Then, turn the lock off, fine tune Z0 to give a flat, near zero frequency signal, increase the 
gain to the maximum and the lock power by 10 units and turn the lock on again.  The lock 
signal should go up indicating that it has engaged.  Reduce the lock power to its previous 
value.  Make a small change to Z1 (Z1C, if present, is the the same as Z1 but the 
adjustments are Coarse) and observe the lock signal.  If the signal increases, continue 
making changes until it begins to decrease.  If it decreases, change the shim in the 
opposite direction.  After Z1 is optimized, proceed in the same manner with Z2 (or Z2C). 
Now, because Z2 interacts with Z1, the latter must be readjusted. Repeat the whole 
procedure several times until no further improvement is possible.  Usually, it is only 
necessary to adjust Z1 and Z2 but you can also adjust Z3 and Z4 to get better line shape. 
If you want to do it, change Z3, then readjust Z2 and Z1 as described and repeat until you 
reach the maximum.  Then proceed with Z4, change it and readjust Z1, Z2 and Z3 as 
described.

Broad, symmetrical peaks indicate that Z1 and Z3 need optimization while asymmetrical 
peaks with long tails or shoulders on either side indicate faulty Z2 or Z4 settings.  The 



NMR Training Guide 10

higher the order of the shim, the closer to the peak's base its effect will be.  Large 
spinning side bands indicate poor non-spinning shims.  These are shims with 
components in the X or Y axes and as the name implies, they must be adjusted with the 
spinning turned off.  If you observe large spinning side bands, turn the spinning off and 
adjust X and Y interactively using the procedure for Z1-Z2.   

Keep in mind that some solvents, particularly acetone and methanol, react more slowly to 
changes in the shims due to their typically long relaxation times.  With these solvents, 
shimming has to be done with low lock powers, slowly and patiently.  

You can also use automatic gradient shimming on all our instruments. This procedure 
shims Z1 to Z5 simultaneously and usually achieves satisfactory results.  To use it, click 
the Gradient Shim button in the Start, Standard panel and wait until it finishes.  If 
your tube requires more than the normal shimming, it may be necessary to run it twice. 
Give it a try, it may even give better results than your manual shimming!  At the very least, 
it will provide a much better starting point to start manual shimming and doesn't even 
require the sample to be locked.  Also, if you are unable to find the lock signal, try 
gradient shimming first.  

It is also possible to shim non deuterated solvents.  To do it, select the equivalent 
deuterated solvent from the list, turn the lock off and select from the main menu: 
Acquisition > Go Gradient Shimming > Use 1H/gradient map.  Locking is 
not possible, of course, but this is not a problem with short term acquisitions, like routine 
1D spectra, as the magnetic field in modern superconducting magnets is very stable. 
Gradient shimming of non deuterated solvents, and manual shimming using the FID is 
described in more detail in a separate writeup.  

A special situation may arise when acquiring a fluorine spectrum in a non deuterated 
solvent.  On spectrometers with automatic tuning capability, it is important to first take a 
proton spectrum to ensure the probe is tuned to proton, then do gradient shimming with 
the proton gradient map and then load parameters for fluorine and tune the probe to 
fluorine.  If you don't follow this order but start by taking a fluorine spectrum, automatic 
shimming will fail because the probe will be tuned to fluorine before shimming with the 
proton gradient map is performed.   

Variable temperature operation

For temperatures above room temperature, all you need to do is enter a value in the 
Start, Spin/Temp panel and click Regulate Temp.  

For low temperature operation we have two choices.  All spectrometers are equipped with 
an FTS cooling unit that can be used to cool the probe to temperatures up to about 
-20 °C.  For lower temperatures, a bucket filled with liquid nitrogen is used.  

Ask the staff for further instructions before using low temperature for the first 
time.  

In either case, be careful no to exceed the limits of the installed probe or the boiling or 
freezing points of your solvent.  Make incremental changes to the temperature not larger 
than 30 °C until you reach the desired temperature.  Keep in mind that the sample will 
require at least 5 to 10 minutes to fully equilibrate to the temperature in the probe, and 
you may need to re-shim or re-tune after large changes in temperature.  

When you are finished, bring the temperature back to room temperature, again in steps 
of 30 °C, and finally click on Temp Off in the Spin/Temp panel to turn off the 
temperature controller.  Allow enough time after your experiments for the temperature to 
recover completely before your time is up.  The next user should find the probe at room 
temperature!  
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Modifying spectral parameters

Before starting the acquisition, you may want to adjust the most common spectral 
parameters.  These are found in the Acquire, Defaults parameter panel.  

Select a different Spectral Width from the list or type in the chemical shift range. The 
default values for some nuclei can be very far from optimum for your sample or may not 
even encompass the values you expect.  Narrowing the range will increase the digital 
resolution.

Select a Number of scans (number of transients: parameter nt) or type any number 
you want in the command line.  For example, low sensitivity nuclei or diluted samples 
may require a large unknown number of scans.  In such cases, enter a large number like 
nt=100000 and stop the acquisition later when enough signal has been accumulated.  

To get a more accurate integration you may need to increase the Relaxation Delay 
(parameter d1).  

A Pulse Angle of 45 or 60 degrees is usually adequate for protons, but in order to get 
quaternary carbons in a carbon-13 spectrum it may help to lower the pulse angle to 30 
degrees.  

Other common parameters may be changed from the Acquisition panel or typed 
directly.  For example, the acquisition time (at) determines the digital resolution of the 
spectrum; if you need high resolution fluorine spectra to accurately measure coupling 
constants, you should reduce the default spectral width and increase the default 
acquisition time.  Do not change parameters that you don't understand and never 
increase pulse or decoupling powers.  

When doing experiments other than simple 1D spectra, it is important, and sometimes 
necessary, to review and perhaps change the parameters in the Pulse Sequence 
panel, where the parameters pertinent to the chosen pulse sequence are accessible. 
Consult the experiment's documentation.

A note about spinning.  Although the default parameters for common nuclei set a 
spinning rate of 20 (Start, Standard or Spin/Temp panels), this is not really 
necessary.  The resolution in a well shimmed, modern superconducting magnet is 
usually such that you may not even notice a difference in the line widths with and 
without spinning, but you may be able to see spinning side bands when the sample is 
spinning and the non-axial shims are far from optimum.  In fact, most 2D spectra are 
recorded with spinning off.  Sometimes, the sample will not spin because of dirt 
accumulated inside the magnet.  Please let us know if this happens so we can clean the 
magnet but don't worry about your spectrum and just turn spinning off.

Before starting the acquisition, you can check the time required by the experiment by 
clicking Show Time.  

Click Acquire or type go, or ga to start the acquisition.  After it has started, it can be 
stopped at any time by clicking Stop or typing aa (abort acquisition).  
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Summary

1. Insert the sample

2. Select an experiment

3. Enter solvent and sample information

4. Lock the magnet

5. Tune the probe

6. Shim the magnet

7. Adjust temperature and other spectral parameters

8. Start the acquisition

Acquisition
As previously mentioned, after an acquisition has been started, you can go to another 
workspace and do a different task, like reading a previous spectrum from the hard disk 
and process it or plot it.  Or you can set up another experiment and start it.  Once the 
undergoing experiment finishes, the new experiment will start.  You can set up and start 
as many experiments as you want.  At the end, you will have your spectra in separate 
workspaces; don't forget to save them!

Another way to create a queue of experiments on the same sample is to click New Study 
in the Holding vertical panel.  You can then select several experiments from the buttons 
on the top of the vertical panel; customize them and run them with a single click on the 
Submit button.  The sample will be automatically locked and shimmed, and the spectra 
will be transformed, plotted and saved.  Read the section Automated Acquisitions further 
ahead for more information.

After the acquisition is started, the FIDs (free induction decays) resulting from each pulse 
sequence, are digitized and temporarily stored in the spectrometer's console (the 
electronics box near the magnet).  The result of each transient or scan is added to the 
previous one to increase the signal to noise.  It is only until a certain number of transients 
have been added (determined by the bs parameter, the block size) that the result is sent 
to the host computer.  From this point on, the data can be transformed and examined: 
you don't have to wait until the experiment finishes (at least for 1D data; 2D data require 
readjusting linear prediction parameters before processing).  Thus you can also monitor 
an acquisition in progress and stop it when you have collected enough scans, or stop it if 
you think your experiment is not going to work.  The status of the acquisition (the number 
of scans collected so far and the time remaining to completion) is displayed in the status 
field in the lower part of vnmrj's window. To stop an acquisition, select from the menu 
Acquisition > Abort Acquisition; or type aa; or click Stop.  Quitting vnmrj while 
an acquisition is in progress does not stop the acquisition.  

Spectra can be saved from the File > Save as... menu;  by typing svf; or by clicking 

the  icon on the user toolbar.  Use only alphanumeric characters (a-z A-Z 0-9), dashes 
(-), or underline characters (_) in your file names: vnmrj does not like any other 
characters (including spaces).  

To eject the sample once you are finished, click the Eject button (Start, Standard 
panel) or type e.  Retrieve the sample from the top of the magnet and click Insert or type 
i.  We do not insert a “standard sample” in the magnets when not in use.  Do not insert 
the empty spinner in the magnet! And remember to log out before you leave.  
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Arrayed acquisitions

Some experiments, like a kinetics or a diffusion experiment, actually consist of collecting 
not one, but a series of spectra.  The set is acquired as a single experiment and stored as 
a single file.  To perform the acquisition, one of the parameter's is set up as an array of 
values.  Vnmrj then acquires the first spectrum with the parameter set to the first value in 
the array, then the second spectrum is collected with the parameter set to the second 
value and so on.  For example, to quickly determine the 90 degree pulse duration, you 
can set up an array of pw values (the pulse width, in microseconds).  You can do it by 
typing the parameter followed by the values separated by an equal sign and commas, 
with no spaces: pw=2,4,6,8,10,12,14; or you can setup the array from the menu 
Acquisition > Parameter Arrays...  The instructions for the experiment you want 
to run will normally tell you what parameters to array and how.  

Automated Acquisitions
If you want a completely automated acquisition, proceed as follows:

1. Insert the sample in the magnet as usual.  

2. Click New Study in the lower part of the Holding vertical panel (shown below), 
or select from the menu Automation > New 
Automation.

3. Enter a Sample Name in the Start, 
Standard panel, and select the solvent and 
other options.  You can select Autoplot to 
have each spectrum plotted; autolock (Lock? 
Yes) to capture the lock automatically, Shim to 
shim the sample and Tune to tune the probe if 
you haven't done it yourself.   

4. In the Experiment Panel, click the buttons 
for the desired experiments  (some, like 
noesy1D require further customization).  

5. Click Submit.  

The experiments selected in step 4 will have default acquisition parameters that may or 
may not be suitable for you.  Typically, you may need to change at least the number of 
transients or the spectral width.  The  experiments may be customized by double clicking 
the experiment name (in green) in the Study Queue window (not the experiment 
button).  The parameter panels for that experiment will open up to allow you to make 
modifications as usual.  Click Save to save any modified parameter and return to the 
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queue entry panel.  Also on the Study Queue window, notice the acquisition times for 
the individual experiments displayed inside brackets to the right of each experiment.  The 
total time for the queue is displayed at the bottom of the Start, Standard panel. 

After each acquisition, the spectrum will be processed and plotted automatically (if 
requested) and the group of experiments (the queue) will be saved in a folder with a 
name consisting of the sample name, followed by the date and a sequence number 
separated by underlines; for example: ealva-1-234-2_20101026_01.  Each FID will be 
saved inside that folder with a name consisting of the sample name followed by the 
experiment name followed by a sequence number; for example: ealva-1-234-
2_HMQC_01.fid.  If you need expansions of your spectra, you will have to open each 
spectrum and plot them manually yourself.  

Processing
When you save a spectrum, the file is stored in the spectrometer's computer, usually in 
your vnmrj folder in /home/uniqname/vnmrsys/data.  Your files will be accessible from any 
workstation in the lab. 

To load a spectrum stored on disk into the current workspace, select Open... from the 

File menu, or click the Open... icon  in the user tool bar just below the main menu 
(hover the mouse cursor over the icons to display their function).  When you use this 
utility on any workstation in the lab, you will see links to all spectrometers.  Clicking a link 
allows you to browse the files and load an FID stored in that instrument.  If Process 
data on drag-and-drop is enabled (Edit > System settings menu), then the 
data will be Fourier transformed and processed automatically for you and it will be almost 
ready to plot: you may still need to check the referencing and phase as described below. 
If automatic processing is not enabled, you can do automatic processing from the menu 
Process > Full Process.  

Processing an NMR spectrum generally involves applying a weighing function to the FID; 
applying linear prediction if needed; doing a Fourier transformation; phase correction; 
adjusting the chemical shift reference; selecting integral regions; baseline correction if 
needed; and possibly getting a list of peak positions.   Most of these task are done during 
automatic processing.  However, it is important to understand how to do them manually 
because the automatic algorithms may not be completely accurate for all spectra.  

The parameters for processing can be adjusted from the Process panels.  Many of 
these parameters can be found in more than one panel and also in some of the vertical 
panels on the left hand side of vnmrj.  The repetition is meant for ease of use but 
sometimes can be confusing.  If you are not sure about a parameter or its value, don't  
change it. 

Weighting function

Select a weighting function and its parameter(s) on the Weighting panel to be applied 
before Fourier transformation.  The parameter for zero-filling is also found here.

Linear prediction

Linear prediction is also applied before Fourier transformation.  Its parameters are 
located in the More 1D or More 2D panels. There is more information on linear 
prediction in a separate writeup.  
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Fourier transformation

Fourier transformation of 1D FIDs can be performed by typing wft, or by clicking 
Transform All in the Default or Weighting panels.  You can also click Transform in 
the action bar.  For 2D data, the appropriate button is called Full 2D Transform.  

Interactive Display manipulation

Once transformed, the spectrum will be shown in the graphics window where it can be 
manipulated with the mouse.  To this effect, there is a tool bar with drop down menus in 
the user tool bar where you can access all mouse functions, and there is also a vertical 
tool bar, shown below, on the right hand side of vnmrj with equivalent buttons.   You can 
display the function of the buttons by hovering the mouse cursor over them. 

If you don't see a vertical red line on the spectrum, click the top button  to get it.  This 

line is the vnmrj cursor and you are now in what we may call “normal display mode”. 
Clicking with the mouse left button (left clicking) and dragging on the spectrum will move 
the cursor horizontally; middle clicking and dragging changes the intensity of the 
spectrum at the cursor position; and right clicking and dragging displays and moves a 
second cursor that can be used for zooming into a spectral region.  You can also get a 

second cursor by clicking on the “Display one or two cursors” button  on the toolbar. 
The middle button has another, special function: if you click on a region very close to the 
left edge of the display, dragging up and down with the middle button will move the 
vertical position of the spectrum instead of affecting its intensity.    

To zoom into a region, first enclose it with the two cursors and then click  .  Or you can 
click   and drag the mouse across the display to zoom in.  If you choose this last 
button,  you will enter into “zoom mode” (the mouse cursor changes into a magnifying 
lens) and you will have to click any other button, like the top button, to get out to normal 

display mode.  Once you zoom into a region, clicking the pan and stretch button  will 
take you to another operating mode where the mouse buttons have reassigned functions, 
but unfortunately in this case the mouse cursor doesn't change shape to alert you.  In this 
mode, dragging the left mouse button pans the spectrum left or right; the middle button 
changes the intensity of the spectrum; and the right button expands the spectrum but in a 
bizarre way that is difficult to control: after you click the spectrum with the right button, 
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any movement in any direction above the point where you clicked stretches the spectrum, 
and to compress it you have to move the mouse to a position below the point you initially 
clicked, possibly stretching it even more as you move the mouse down.  Click the top 

button  in the toolbar to exit this mode.  

Phase correction

The Free Induction Decay (FID) data set is a function of a complex number, the intensity, 
versus time.  During Fourier transformation, this function is converted to a function of 
intensity (but still a complex number) versus frequency.  The spectrum displayed on the 
screen should correspond to the real or absorptive portion of the function, but it may 
contain “imaginary” 
or dispersive 
contributions as 
shown in the 
spectrum below.  If 
you chose 
automatic 
processing or 
automatic phase 
correction 
(Autophase button 
in Process, 
Default panel), 
the spectrum will 
probably be 
phased correctly.  But on occasions, you will need to fine adjust it manually. 

To phase a spectrum, first click the Phase button  to enter into phase correction mode. 
Left click on any portion of the spectrum close to its right edge and drag the mouse up or 
down until the rightmost peaks in the spectrum have only positive components; don't 
worry about the peaks on the left side of the spectrum yet.  The right mouse button can 
also be used for fine adjustments.  Then, left click close to the left edge of the spectrum 
and drag the mouse up or down until the peaks on the left side of the spectrum are 
completely in phase (positive intensity).  Repeat the procedure if necessary until the full 
spectrum is properly phased.  Click the top button on the toolbar to get out of phase 
correction mode.  

Chemical shift referencing

Generally, the chemical shifts in the spectrum should be acceptable.  By default, the 
chemical shifts are referenced using the solvent peak's deuterium signal.  However, if you 
want to be more accurate, or if you have an unusual or non deuterated solvent, you may 
need to reference the chemical shifts manually using an internal standard like TMS.  

The reference can be set on the Process, Default or Display panels.  Expand a 
small region around 
your internal 
standard, place the 
cursor in its center 
and enter the 
standard's chemical 
shift in the Reference 
cursor to field.   

After acquisition, the 
chemical shift of any 
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other nucleus will also be automatically referenced using the solvent's deuterium peak. 
But IUPAC recommends using the proton peak of the internal standards TMS for organic 
solvents and DSS for H2O or D2O. To reference any other nucleus in this manner, 
proceed as follows:

1. take a proton spectrum in workspace 1 and set the chemical shift of the internal 
standard (0 ppm for TMS or DSS) 

2. take the spectrum of the nucleus of interest in another workspace, for example 2

3. type mref(1,2) in the command line to “move the reference” from workspace 1 
to workspace 2.  

Your spectrum is now referenced according to IUPAC without the need for cumbersome 
external references!  (Pure Appl. Chem. 2001;73:1795-1818).

Integrating the spectrum

As a part of autoprocessing, integral regions are selected and the integrals' level and tilt 
are corrected.  You may only need to normalize the areas by assigning a value to one of 
the integrals.  To do 

it, first click the  
button in the vertical 
toolbar to display 
the integrals; place 
the cursor over one 
of the integrals, and 
in the Process, 
Integration 
panel select 
Normalize Area 
To: Single Peak; 
enter a value in the 
Integral Area 
field and click the 
Set Integral Value 
button.  The 
integrals' values can 
be displayed with 
the button Display 
List of Integrals or 
with Show Integral Values.  

If you want to select integral regions manually, first reset the regions previously defined, if 
any, with the Clear Integrals button.  Then, select Partial under Integral Display 
Mode, click on Interactive Resets and define the regions by clicking on the spectrum 
over the left and right limits of each region that you want to create.  Always define the 
areas so they enclose some empty baseline on both sides.  When you are done, click the 
top button on the vertical toolbar to get out of this “region selection” mode.   

It is also common to find that the whole integral “baseline” is not straight and horizontal: it 
may be tilted and may show a curvature.  If that is the case, to  get accurate integrations 
you will need to correct it manually.  Select Full under Integral Display Mode and 

click the Integral Lvl/Tlt button  in the toolbar.  Next, click on the left side of the 
spectrum and drag the mouse up and down until the integral baseline on that side of the 
spectrum is horizontal, then click on the right side of the spectrum and drag the mouse 
until the integral baseline is straight and horizontal across the spectrum.  You may need 
to repeat the procedure to obtain optimum results.  As usual, click the top toolbar button 
to get out of this operation mode.  Notice that it is common to see some curvature or tilt 
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close to one or both edges of the spectrum: this is usually unavoidable.  

Selecting Partial, Full, or Off under Integral Display Mode is equivalent to 

clicking the Show Integral Regions button  , the Show Full Integral  , or the Hide 

Integrals  button on the toolbar.   Also notice that while the integrals are being 
displayed, the middle button will act on their intensity and not the spectrum's.  

Baseline correction

There are two types of baseline correction available in vnmrj.  The first one is a drift 
correction that only rectifies spectra with a spectral baseline that is straight but tilted or 
that has non zero 
intensity.   The 
second one can 
correct a spectrum 
with a curved 
baseline.  Both can 
be applied from the 
Process, Display 
panel.  Click DC 
Correct to apply a 
drift correction, or 
BC Correct to 
apply a curvature correction.  In the latter case, you need to have defined integral regions 
previously; click Autofind Integrals if you haven't defined regions before clicking BC 
Correct.  

Getting a list of peak shifts

A list of peaks can be easily obtained with vnmrj.  In the Process, Cursors/Line 

Lists click Peak Threshold or the Threshold button on the toolbar  ; move the 
horizontal line to the lowest position in the spectrum where you want peaks to be listed, 
and click Display Line List.  

Processing of arrays and 2D spectra  

The processing of arrays of spectra is usually done in essentially the same way as with a 
simple 1D spectrum, but there may be additional processing required depending on the 
data to be extracted from the experiment; consult the documentation for instructions. 
Phase correction, integration and referencing are usually done on the first spectrum in 
the array.  We have created macros to allow you to apply a baseline correction to all 
spectra in an array (UMbc) and to get a listing of all integrals in the array (UMdli).  Read 
Kinetics Experiments with Vnmrj for more information. 

Two more buttons will appear at the top of the tool bar to allow you to navigate 
between the spectra in the array.  In addition, the ArrayedSpectra vertical 
panel contains buttons and parameters to display and plot stacks of spectra in 
many different ways.  And you can also try our custom macro, UMdsarray,  which 
will attempt to display the array with a nice slanted stack layout.  

Processing of 2D spectra is described in a separate writeup.  

Plotting
In vnmrj, a plot is created by choosing (adding together) its components, like the scale, 
the spectrum or the parameters and finally sending the result to the printer.  Each 
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component is selected by pushing a button on the Process, Plot panel shown below.  

First, choose the plotting options for the spectrum, parameters, integrals and peak 
frequencies.  These are selected from the drop down menus in the Plot Setup section 
of the panel.  For the Plot (spectrum) you usually want to select As Displayed to plot 
only the region currently displayed on the screen.  For the parameters, Basic (left) 
prints only the most important parameters, and Full (left) prints almost all acquisition 
and processing parameters.  To plot the integrals, they must first be displayed on screen, 
and Scaled, Horiz. is the most common option.  You can choose any of the options 
and click on Show to preview your selection on the screen.  For the peak frequencies, 
there are quite a few choices suitable to different spectra; the most common are On 
Peaks, top, ppm and As a List.   Other options, like the width or height of the plot 
can be controlled from the command line or from the ArrayedSpectra vertical panel.

Once the layout is chosen, the easiest way to plot, as usual, is to select an automatic 
procedure.  You can either click Automatic Plot Page to have a plot with the spectrum, 
scale and parameters sent directly to the printer, or click Auto Plot Preview to send it to 
an Adobe Acrobat Reader window as a pdf image for your review.  Or you can create the 
plot manually by clicking the elements that you want, like Plot Spectrum, Plot Spectrum 
Scale, Plot Parameters, Plot Integrals, etc.  Once you clicked the elements, click on 
Plot Page or Plot Preview to send your composition to the printer or to Acrobat Reader 
respectively.  Clear Plot will remove your composition from memory to start all over; and 
our custom macro, UMmailpage, will send you the plot via email as an encapsulated 
postscript file and a high resolution image file (png format) ready to be inserted into word 
processing or presentation documents.  

Although our laser printer prints in black and white, plotting in color is possible if you 
create an image or plot file as described below and print it on your own color printer. 
The options or colors are selected in the Styles and Themes window which is 
displayed when you select Display 
options.. from the Edit menu.  Two 
themes have been preconfigured in our 
lab: UM_color and UM_gray.  The first 
plots the elements of the plot in different 
colors, and the second uses only black 
and different shades of gray.  Choose a 
theme on the drop down menu of that 
window and click Load.  The colors can 
also be changed, if needed as follows. 
For 1D plots, select the DisplayColors 
tab and Plot Postscript in the drop 
down menu.  Then click on the color 
button or on the drop down menu to the 
right of each element and select or create 
a color.  For 2D spectra, select the 2DColors tab and Plot Postscript from the drop 
down menu.  Then click on either Absolute or Phase for the kind of 2D spectrum to plot 
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(for example, a cosy or an hmbc are usually displayed in absolute mode and an hsqc or 
noesy in phase sensitive mode).  Select a color for each of the contour levels on the plot 
as described above for the 1D elements.   Click Close to accept the changes or 
Abandon to discard them and finish.  

To plot with a different line width, create the plot manually as described above and then 
type pagelw(x),  where x is the desired linewidth in points.  The default width is 3: 
choose 1 for the finest and 5 to 9 for thicker lines. 

Miscellaneous
There is more information about doing other common tasks, like transferring files via ftp 
or flash drives, or burning DVDs in the Frequently Asked Questions writeup available in 
our web page (http://www.umich.edu/~chemnmr/   docs.html  ).  

Please notify the staff of any change in lab affiliation or recharge account.

Recovering from problems

Problems arising from the hardware or software will inevitably occur.  The most common 
problems and their solutions have been compiled in the document Common Problems 
and Solutions which is available in our web site and also in a white binder in the lab.  Of 
these, possibly the most common is due to disrupted communications between the host 
computer and the spectrometer's console.  This one can manifest itself as an 
unresponsive vnmrj or in many other ways, and is usually fixed by typing abortallacqs 
in the command line.  Please consult Common Problems and Solutions for details.  

Never power cycle the computers.  You will risk a real probability of corrupting 
the file system beyond recovery. 

Our instruments
We currently have six Varian (now Agilent) spectrometers in our facility.  Additional 
technical details can be found in our web page.

Gallium is a 400MR spectrometer equipped with an AutoX-DB direct-detection probe and 
automatic tuning.  The temperature range is -80 to +130 ºC.  This probe is capable of 
detecting 1H, 19F and any nucleus with a frequency between those of 31P and 15N.  It is 
more efficient for X-nuclei detection experiments (nuclei other than 1H or 19F). 

Cobalt is a 400MR spectrometer equipped with a auto-switchable probe that is 
permanently tuned to 1H, 19F, 13C and 31P.  The temperature range is -20 to +80 ºC.  This 
instrument is currently in walk-on mode of operation (no previous reservation is required) 
and is meant for quick routine analyses of synthesis products.

Tin is an Inova 500 spectrometer.  It has two probes available: the id probe (the default) 
is an indirect detection probe without fluorine capability, temperature range -20 to 50 ºC 
optimized for proton detection; the sw probe is an indirect detection probe, temperature 
range -100 to 150 ºC, optimized for heteronuclear detection.  The probes are switched 
and manually tuned by the staff upon request.

Zirconium is an Inova 400 spectrometer.  It has only one probe that is permanently 
tuned to 1H, 19F, 13C and 31P.  The temperature range is -20 to 80 ºC.  It is currently 
installed in room 2407 and is used for undergraduate teaching.  

Tellurium is a VNMRS 500 spectrometer with automatic tuning, three RF channels and 
two probes.  The OneProbe (the default) has a temperature range of -80 to 130 ºC and 
excellent sensitivity for 1H, 19F, 13C and other heteronuclei and is suitable for all kinds of 

http://www.umich.edu/~chemnmr/docs.html
http://www.umich.edu/~chemnmr/
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experiments.  The HFX probe is tuned to 1H, 19F and X, with a temperature range of -80 
to 130 ºC and is used for triple resonance experiments involving fluorine; for example 
proton acquisitions with fluorine decoupling and viceversa, or HF heteronuclear 
Overhauser experiments (HOESY).  This instrument is typically used for long term 
experiments.  

Ytterbium is a VNMRS 700 spectrometer with automatic tuning, three RF channels and 
two probes.   The AutoX-BB probe (the default) can be tuned to 1H and any nucleus from 
31P to 15N.  This probe has a temperature range of -80 to 130 ºC and is used for the 
detection of proton and heteronuclei but cannot detect fluorine.  The sensitivity for 
carbon-13 is the best in the lab.   The HCN probe is a triple resonance probe tuned to 1H, 
13C and 15N, with a temperature range of -20 to 80 ºC and is used for proton detection 
and triple resonance experiments.  The sensitivity for proton with this probe is the best in 
our lab.  This instrument is typically used for long term chemical and biomolecular 
experiments.

Facility rules and safety

General Safety Guidelines

1. No food or drinks are allowed in the lab.  

2. No radioactive, or highly dangerous biological or chemical samples are allowed in the lab.  

3. Working with chemicals or preparing samples on the computer desks is not allowed.  Use the fume 
hood for that purpose.

4. Gloves are not allowed when typing on the keyboards or using the spectrometers.  Gloves can be 
used when working at the fume hood. 

5. Metallic objects, whether small or large may constitute a hazard to the instrument and to the user and 
are not allowed near the magnets.  

6. Samples broken outside the magnet should be thoroughly cleaned up and reported to the staff. This 
includes everything that came into contact with the sample: the working surface, desk, depth gauge, 
spinner, etc.  Never insert the sample tube into the spinner above the keyboard (or even above the 
desk); cleaning it will be very difficult in case the tube breaks, and all users will likely get 
contaminated fingers.  

7. Samples broken inside the magnet should be reported to the staff immediately, and a note stating that 
the instrument is out of order should be visibly posted on the computer keyboard.  

8. Superconducting magnets may occasionally quench for a variety of reasons.  During a quench, the 
liquid helium inside the magnet's cryostat is boiled off very rapidly, resulting in a fast and massive 
release of helium gas along with a loud sound.  Although helium is not toxic, it will reduce the oxygen 
concentration in the lab's atmosphere which may lead to disorientation, loss of conscience and 
suffocation.  If you observe a large exhaust of white gas coming out from one of the magnets, or a 
large condensation cloud at the lab's ceiling, vacate the lab immediately and notify the staff.  Wait at 
least one hour to re-enter the lab.  The Facility is equipped with oxygen sensors.  If the alarm is 
triggered, exit the lab immediately. 

Usage Rules

1. The departmental NMR center is a multi-user facility; and all users must be considerate of the sign-up 
rules in order for everyone to be accommodated.  Recurrent violation of the rules by any individual 
will not be tolerated and could result in loss of NMR privileges.

2. Use of the spectrometers is restricted to U of M's faculty, graduate students, postdoctoral fellows and 
other authorized persons after successful training and approval.  Undergraduates engaged in long 
term independent research projects under faculty direction will be trained on these instruments upon 
their supervisor's request.  

3. Only persons who have received or are receiving training, or are otherwise authorized are allowed in 
the lab.  Users with pacemakers or other medical implants are not allowed near the magnets and 
must consult with the staff for approval.

4. Haphazard experimentation with the NMR hardware will not be tolerated under ANY circumstance; 
violation of this policy will result in immediate and permanent loss of NMR privileges.  Users are not 
authorized to change or tune probes or modify hardware except as instructed during training or after 
proper authorization. If there is trouble with any of the NMR instruments, ask the NMR staff for help. If 
the NMR staff is not available, consult the “Common Problems and Solutions” handout available on 
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the lab's web site or wait for help before proceeding.  Report all hardware or software malfunctions as 
soon as possible.  

5. It is the responsibility of all users to learn the capabilities of each instrument to avoid damage and 
maximize efficient use of the NMR hardware.   For example, the allowed temperature range is 
determined by each probe's design; exceeding it may result in permanent damage.   Instrument 
descriptions and capabilities are posted on the lab's web site.  

6. Any given user can only reserve time for him/her-self; that is, a single user cannot use the time 
reserved under the name of a different user except when that user is late.  Additionally, a user can log 
in only using his own account; logging in under another user's account is not allowed.

7. Users may not sign up for contiguous time slots if they span a prime time boundary (9 am or 9 pm). 
For example, a user may not sign up for 8 pm to 9 pm and 9 pm to 10 pm (9 pm boundary is 
spanned); or from 9 pm to 9 am and 9 am to 10 am (9 am boundary is spanned).  The only exception 
is if you have already signed up for the time before the boundary and it is currently less than one hour 
before this boundary then you can sign up and continue using the instrument after the boundary.  For 
example, if you reserved from 10 pm to 9 am, and it is now 8:10 am and no other person has 
reserved the instrument after 9 am, then you are allowed to enter a contiguous reservation starting at 
9 am.  The purpose of this exception is to maximize use of the instruments that would otherwise go 
unused. 

8. A user will forfeit his/hers scheduled time if he/she is more than 5 minutes late according to the clock 
in the NMR room.  But please, if you don't need your scheduled time or a portion or it, cancel or 
truncate your reservation so the time is available to other users.

9. All users must use the remote stations for data analysis.  Of course, you can use a spectrometer for 
data analysis if you are currently using it for acquisition. There is no charge for use of the 
workstations.  All research groups are encouraged to purchase a Linux workstation, or Macintosh OS 
X 10.3 computer. The department has a site license for the VnmrJ NMR software.  There is also a 
workstation available with Mestrelab Research's MestReNova for processing of NMR data.  

10. Users who need more than the permitted time during peak hours, or need the assistance of the NMR 
staff to perform non-routine experiments, can schedule longer time blocks during the day if approved 
and scheduled by the NMR staff.  

11. As of May 2009, use of the 500 MHz instruments will be recharged at a rate of $13.50 per hour and 
all other instruments will be recharged at $9.50 per hour.  Academic, non University of Michigan users 
are charged at $33.80/hr for the 500 MHz and $24.70/hr for all other instruments.  Commercial users 
are charged at $67.60/hr when the spectrometer is operated by the user or $135.20/hr when operated 
by the staff or when data analysis is requested.  

Signup rules (03/31/11)

Inova-500:

a) Monday to Friday from 9 am to 9 pm:  10 minute time blocks up to a maximum of 1 hour per user per 
day.

a) Monday to Friday from 9 pm to 9 am:   10 minute time blocks and unlimited time.

b) Saturday and Sunday: 10 minute time blocks and unlimited time; 24 hour advance reservation for 
blocks longer than 5 hr.

Gallium-400:

a) Monday to Friday from 9 am to 9 pm:  10 minute time blocks up to a maximum of 1 hour per user per 
day.

a) Monday to Friday from 9 pm to 9 am:   10 minute time blocks and unlimited time.

b) Saturday and Sunday: 10 minute time blocks and unlimited time; 24 hour advance reservation for 
blocks longer than 5 hr.

Cobalt-400:

a) This spectrometer is walk-on (no reservation is necessary), limited to 15 minute time blocks. Use of 
additional contiguous time beyond 15 minutes is permitted if there are no users waiting for the 
machine. When other users are waiting, you should finish your work within your allowed time and 
notify them when  you are done. 

Tellurium-500:

a) Monday to Friday from 9 am to 9 pm:  10 minute time blocks up to a maximum of 5 hours per user per 
day.
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a) Monday to Friday from 9 pm to 9 am:   10 minute time blocks and unlimited time.

b) Saturday and Sunday: 10 minute time blocks and unlimited time; 24 hour advance reservation for 
blocks longer than 5 hr.

Ytterbium-700:

a) Monday to Friday from 9 am to 9 pm:  10 minute time blocks up to a maximum of 5 hours per user per 
day.

b) Monday to Friday from 9 pm to 9 am:   10 minute time blocks and unlimited time.

c) Saturday and Sunday: 10 minute time blocks and unlimited time; 24 hour advance reservation for 
blocks longer than 5 hr.
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